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Kapitel 1. Installation & Einstellungen 

Terminologie 
In diesem Handbuch werden verschiedene Abkürzungen verwendet.  

 LMT  linke Maustaste 

 RMT  rechte Maustaste 

MMT  mittlere Maustaste/Scrollrad 

 

Standardpfade bei der Installation 
Wird bei der Installation nichts anderes angegeben, installiert Pulsonix in den folgenden 

Pfaden: 

 Programm 
Pulsonix Programmdateien und Bibliotheken:  C:\Programme\Pulsonix\ 

 Beispiel Designs und Tutorials 
Vorgefertigte Pulsonix Beispiele: C:\Programme\Pulsonix\\Examples 

 Bibliotheken 
Pulsonix Standardbibliothek:  C:\Programme\Pulsonix\MasterLibraries 

Anwender Bibliothek: C:\Programme\Pulsonix\UserLibraries 

 Steuerdateien 
Regeln:  C:\Programme\Pulsonix\Technology 

Grafische Profile:  C:\Programme\Pulsonix\Profiles 

Macros für Reporterstellung:  C:\Programme\Pulsonix\Formats 

Scripts (VBS; JAVA):  C:\Programme\Pulsonix\Scripts 

Hierarchische Blöcke:  C:\Programme\Pulsonix\Blocks 

Farbsettings:  C:\Programme\Pulsonix\Colours 
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Setup > Folders 
Speicherorte im Pulsonix sind frei definiert. Die Einstellungen finden sich im Menü 

Setup > Folders 

Dieser Dialog definiert die persönlichen Einstellungen der Software. Die Einstellungen 

sind anwenderabhängig und wirken auf dem verwendeten Computer. Sie werden aber 

nicht im Design gespeichert. 

Die Folders Einstellungen können mit File > Save Configuration gespeichert und  mit 

File > Load Configuration eingelesen werden. 

 Das Register General definiert den Ort/Ordner in dem Pulsonix bei 

Dateioperationen (Öffnen, Speichern) als erstes sucht. 

 

Always start in this folder: Ein genau definierter Ordner. 

Remember last folder used when Application closes: Pulsonix merkt sich, 

beim Schließen des Programms, den zuletzt benutzten Ordner. 

As defined by Operating System: Pulsonix verwendet die von Windows 

vorgegebene Methode. 

General Folder: Es kann ein Ordner angegeben werden in den alle nicht extra 

definierten Ausgaben geleitet werden. 

 
 

 Die Register  Design Backups, CAM/Plot und Reports sind praktisch  

identisch aufgebaut. In Ihnen wird die Ordnerstruktur für Ausgaben  

festgelegt.  

Design Folder: Die Daten werden im gleichen Verzeichnis abgelegt, in dem 

auch die Schaltplan und PCB Layout Datei liegen. 

This Folder: Es wird ein spezieller Ordner definiert, dieser gilt für alle 

Projekte. 

This Folder below design file : Es wird im Projektverzeichnis ein Ordner mit 

dem angegebenen Namen erstellt und die entsprechenden Ausgaben dorthin 

geleitet.:  

General Folder:Es wird der General Folder aus dem Register General 

verwendet.  
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 In den Registern Libraries, Technology Files, Profile Files, Schematic Blocks 

und Colour Files werden die aktiven Ordner und Dateien für bestimmte 

Vorlagen festgelegt (Bibliotheken, Technologien, Profile, Vorlagen für ASCII 

Reports, vorbereitete hierarchische Blöcke und Farbeinstellungen). Auch 

diese Register sind praktisch identisch aufgebaut. 

 

 Der Bereich Folders and Search Order definiert Suchpfade und aktive 

Dateien . 

 Der untere Bereich File Found zeigt die in den Suchpfaden gefundenen 

Dateien.  

 Pulsonix durchsucht die Pfade und Dateien in der angegebenen Reihenfolge, 

weshalb diese auch per Up/Down Schalter angepasst werden können. Sollten 

Elemente in mehr als einer Datei vorkommen, hört Pulsonix mit der Suche 

auf, sobald der erste Fund vorliegt.  

 Mit den Schaltern Folder Enabled bzw. Enabled können Pfade und einzelne 

Bibliotheken vorübergehend abgeschaltet werden. Diese erscheinen dann 

ausgegraut. Setzen der Schalter aktiviert diese Elemente wieder. 

 Delete löscht Einträge 

Wichtig!   

Ein Delete im oberen Bereich Folders and Search Order löscht nur die 

Verknüpfung zu diesem Verzeichnis, aber keine Dateien. 

Ein Delete im unteren Bereich, löscht die Datei (Bibliothek) physikalisch vom 

Datenträger! 

 

http://www.tecnotron.de/


Pulsonix Seminar 9 

Tecnotron elektronik gmbh Wildberg 64 88138 Weißensberg 

www.tecnotron.de  08389 / 9200 - 406 

Tools > Customize 
Dieser Dialog definiert die persönlichen Einstellungen der Oberfläche. Die 

Einstellungen sind anwenderabhängig, wirken also auf dem verwendeten Computer, 

werden aber nicht im Design gespeichert. 

Die Customize Einstellungen können mit File > Save Configuration gespeichert und  

mit File > Load Configuration eingelesen werden. 

 

 Commands: Hier werden die Werkzeugleisten angepasst und mit 

zusätzlichen Schaltern versehen. Die Werkzeuge werden einfach per Drag-

and-Drop platziert und entfernt. 

 
 

 Toolbars: Zum Ein-/Ausschalten der einzelnen Werkzeugleisten 

 
 

 Tools: Anlegen von Verlinkungen zu anderen Programmen, als Direktaufruf 

aus Pulsonix (z.B. Rechner, Texteditor, sonstige Programme) 
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 Menu: Erlaubt das designabhängige (Schaltplan, PCB, Bibliothek, ...) 

Anzeigen von Menüs. In diesem Dialog können die Grundeinstellungen 

zurückgesetzt werden (Reset). 

 
 

 Keyboard: Zum Belegen und Modifizieren von Hotkeys. Mit den Assignment 

Report Schaltern können Listen der Tastenbelegung erzeugt werden. 

 
 

 Application Look: Steuert das Aussehen der Oberfläche. 
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 Options: Steuert das Aussehen und Verhalten der Werkzeugleisten (Tipps, 

Größe der Icons), das Verhalten der Menüs (Vollständig sichtbar, oder nur 

oft gebrauchte Befehle), sowie der Dockable-Windows. 

 
   

 

Tipp: Wenn Sie die dynamischen Menüs stören (Anzeige nur der oft 

verwendeten Befehle in den Menüs), schalten Sie Menus show recently used 

commands first ab. 
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Tools > Options 
Dieser Dialog definiert die persönlichen Einstellungen des interaktiven Verhaltens. 

Die Register sind zum Teil designabhängig (Schaltplan/PCB). 

Dieser Dialog definiert die persönlichen Einstellungen der Oberfläche. Die 

Einstellungen sind anwenderabhängig, wirken also auf dem verwendeten Computer, 

werden aber nicht im Design gespeichert. 

Die Options Einstellungen können mit File > Save Configuration gespeichert und  mit 

File > Load Configuration eingelesen werden. 

 

 Design Backups definiert die Möglichkeiten der Sicherheitskopien.  

- Security Copies sind zeitgesteuert 

- Backup Copies werden beim manuellen Speichern (Save oder Save As) 

angelegt 

- Restore Points entsprechen den Wiederherstellungspunkten beim Windows, 

hier kann man einen Designstand bewusst sichern. 

 

Es können für jeden Sicherungstyp eignen Pfade und Dateibezeichnungen 

angegeben werden. 
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 Display steuert die Anzeige, z.Bsp. wie überlappende Elemente dargestellt 

werden (Merge Colors), ob Bohrlöcher im Design angezeigt werden (Draw 

Drill Holes), ob Verbindungspunkte auf Pins generiert werden (Draw Implied 

Junctions on Pins), oder ob Kupfer durchsichtig dargestellt wird (Translucent 

Copper). 

 
 

Edit Track steuert die Behandlung von Leiterbahnen, wie z.Bsp. Orthogonal oder 

Diagonal Routen, Bedeutung des Doppelklicks beim Routen oder die Verwendung 

des Push&Shove Routers. 

 
 

 Edit Shape steuert das Zeichnen geometrischer Formen, z.Bsp. 

Orthogonal/Diagonal zeichnen.  
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 Unter File Extensions können die Dateinamen nach  eigenem Bedarf 

angepasst werden. Z.Beispiel die Endung für die IDF Daten, oder mehrere 

möglichen Endungen für denselben Dateityp (*.stp; *.step). 

 

 

Find regelt das Verhalten der Find Option: sollen gefundene Objekte selektiert 

werden, sollen sie blinken, in welchem Umfang findet die Suche statt. 

 
  

 General definiert das Handling. Z.Bsp. wie sensibel reagiert die Maus, wie 

viele Undo Level sind gewünscht, welche Form hat der Cursor. 
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 In-Place Names steuert das Aussehen der Pad Namen und der Netznamen. 

 
 

Interaction steuert das Handling von Objekten. Z.Bsp. wie arbeitet das Selektions-

Werkzeug, wie verhält sich Pulsonix beim Verschieben, sollen Tooltipps angezeigt 

werden, wie arbeitet der Crossprobe. 

 
 

 Move steuert das Bewegen von Bauteilen. Z.Bsp. ist ein Push&Shove 

gewünscht, werden Verbindungen automatisch hergestellt, sollen 

Komponenten auf Hilfslinien fangen. 
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 Macros steuert das Verhalten beim Ablauf eines Macros 

 
 

 Multi-Screen ermöglicht und steuert die Verwendung zweier Monitore. 

 

  

Online DRC definiert welche Regeln Online geprüft werden und ob diese 

grafisch angezeigt werden. 

 
 

 Resolve Net Names steuert die Vergabe der Netznamen beim Kopieren von 

Schaltungen. 

 
 

  

http://www.tecnotron.de/


Pulsonix Seminar 17 

Tecnotron elektronik gmbh Wildberg 64 88138 Weißensberg 

www.tecnotron.de  08389 / 9200 - 406 

 Track Length Limits beinhaltet die Einstellungen für das interaktive 

HighSpeed Routing 

 
 

 Warnings setzt den Warnstatus. Wurde ein Warndialog bei der Arbeit 

abgeschaltet, dann lässt er sich hier wieder aktivieren. 
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Design Einstellungen 

Design Settings 

Die Design Settings sind im Setup Menü verfügbar. Hier werden die grundlegenden 

Designeinstellungen vorgenommen. 

In den Registern werden für die entsprechenden Objekte Einstellungen vorgegeben, 

wie z.Bsp. Textstil, Text Alignment, Linienstil, Standardlagen, Aussehen der 

Bemassung, u.v.m. 

 Man findet hier allgemeine Design Objekte, wie den PCB Safe Mode 

 Hier sind Standardeinstellungen für neue Designobjekte definiert 

 Ändern der Lage des System Origin (Nullpunkt des Koordinatensystems) 

 Ändern der Lage des Relative Origin (Relativen Nullpunkts) 
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Technology 

 Enthält die Regeln für ein Design (Lagenaufbau, Netze und Netzklassen, 

Padstacks, Abstände und Leiterbahnbreiten, usw.  

 Die Technology wird in Kapitel 3. detailiert besprochen. 

Colours 

 Hier werden die Farben und Sichtbarkeit eingestellt 

 Die unterschiedlichen Objekttypen sind nach Registern geordnet 

 Displayed definiert die Sichtbarkeit eines Objektes 

Selectable definiert, ob ein Objekt angefasst (selektiert) werden kann 

True Width steuert die Breite der dargestellten Objekte 

Colours definiert die Farbe der Objekte 

 

 Colours können gespeichert und geladen werden 

 Gespeicherte Colours können im dockable Window ‚Colours’ direkt 

ausgewählt werden 

Raster / Grids 

 Für unterschiedliche Designobjekte können eigene Raster definiert werden 
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 Rasterabstände können dezimal sein (zum Beispiel 8.33) 

 

 

 Raster können im PCB für radiale Platzierung als Polar Grid definiert werden  

 Es können den unterschiedlichen Objekten eigene Raster zugewiesen werden 
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Einheiten / Units 

 Hier wird die gewünschte Masseinheit und ihre angezeigte Genauigkeit festgelegt 

 Folgende Nullen können unterdrückt werden 

 Gerundete Werte können durch Indikatoren angezeigt werden. 
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Kapitel 2. Pulsonix Grundlagen 

Programmoberfläche 

 

MDI & Workbook Modes 

 

 Pulsonix verwendet ein Multiple Document Interface (MDI) 

 Der Workbook Modus erlaubt es, alle aktiven Fenster als Register anzuzeigen 

 

Undo 

 Pulsonix ermöglicht ein mehrfaches Undo und Redo 

 Die Level Einstellung befindet sich unter Tools > Options > General 
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Shortcut Menüs 

 Die RMT wird zum Öffnen der Shortcut Menüs verwendet 

 

Zoom Optionen 

Maustasten und Mausrad 

 

 Sie können auch View Board und View Extents verwenden 

 Frame View – F 

 View Extents – A 

Highlight 
Wird verwendet um ein Netz im Design farbig zu markieren 

 Der Hotkey <H > wechselt zwischen den Mark Net Zuständen an und aus 

 Entfernen Sie markierte Netze mit Remove Highlights im RMT Menü 

 Die Highlight Farbe wird im Colours Dialog unter Highlights eingestellt 
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Properties 

 Properties (Eigenschaften) sind für alle Designobjekte verfügbar 

 Manipulationen der Objekteigenschaften, wie zum Beispiel Position, Drehwinkel, 

Mirror Status, und so weiter sind möglich 

 

 Der Properties Dialog ist über das RMT-Menü verfügbar 

 Der Hotkey ist  <I > 

Find 

 Viele Designobjekte können per Auswahl aus der Liste gefunden werden 
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 Das Verhalten für gefundene Objekte wird über den Dialog der RMT eingestellt 

         

 Schalten Sie Use Filter ein, um mehr Suchkriterien zu nutzen 

 Die Filterung kann auf Namen und Attribute erfolgen so wie auf Attributszustände 

 Der Zustand des Attributs kann eingestellt werden 

 

Lock & Unlock 

 Mit Lock werden Designobjekte fixiert, so dass sie nicht verschoben oder 

verändert werden können 

  

        

 In diesem Modus werden Modal Cursors verwendet  

 Wenn versucht wird ein gesperrtes Objekt zu bearbeiten , wird ein Warnungs-

dialog angezeigt: 
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Absolute/Relative Mode 
Pulsonix erlaubt Arbeiten im Absolute und Relative Modus 

 Der Wechsel zu relativen/absoluten Koordinaten erfolgt im Design Settings 

Dialog im Register Coordinate System, oder durch Doppelklick auf die Angabe 

Abs, beziehungsweise Rel, im Statusbalken  

 

 Relative Koordinaten beziehen sich auf den Relativen Nullpunkt, dieser wird 

entweder manuell im Design platziert oder die Position wird in den Design 

Settings im Register Coordinate System definiert. Die Statuszeile zeigt nun Rel für 

relative Koordinaten, und die Koordinaten in Bezug auf diesen Ursprung. 

 

Run Command 

Der Befehl Run Command wird verwendet um Befehle in Pulsonix zu starten 

 Alle in Pulsonix verfügbaren Befehle sind im Run Command aufgelistet 

 

 Die Support Option ist in diesem Fenster verfügbar, falls sie vom technischen 

Support benötigt wird. 
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Kapitel 3. Technology Files 

Übersicht 

 Technology Files werden verwendet, um die Regeln des Designs festzulegen, zum 

Beispiel Styles, Net class names, Grids, Colours, Units und  so weiter  

 Sie werden verwendet, um schneller die Grundeinstellungen verfügbar zu haben 

und die Designkonsistenz sicherzustellen 

 Ihr Hotkey ist <T>, und sie sind außerdem über das Setup Menü verfügbar 

 Sie können auf verschiedene Art verwendet werden: technologieabhängig, 

firmenabhängig, kundenabhängig für Designbüros 

 Technology Files sollten für Designs und Bibliotheken identisch sein 

 Unterschied zu Profile Files – Technology Files enthalten keine Designobjekte 

Schematic & PCB Technology Files 

 Es gibt separate Technology Files für Schaltpläne und PCB Designs (und für 

Bibliotheken) 

 Schaltplan Technology Files enthalten keine physikalischen Informationen wie 

Leiterbahnbreiten 

Profile Files 

 Profile Files können für den Start eines Erst-Designs verwendet werden 

 Diese Dateien können Objekte, wie Zeichenrahmen enthalten 

Schematic Technology Files 

 Wichtige Schaltplan Design Objekte sind: Pin Styles, Connections, Line Styles 

und Text Styles 

 Es enthält außerdem Rules und Nets/Net Classes, CAM Plot Info, Attribute names 

und Group names 
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Schaltplan & PCB Technology Zusammenarbeit 

 Schaltplan und PCB Designs sind über die Verwendung der Net Class Name 

Einträge in beiden Editoren miteinander verbunden 

 Net Name enthält eine Net Class 

 Net Class enthält außerdem einige elektrische Regeln, die übertragen werden 

 Verwenden Sie unterschiedliche Net Class Names, um unterschiedliche Track 

Styles (Breite) ins PCB zu übertragen 

 

 

PCB Design Technology Files 

 Wichtige Design Objekte beinhalten physikalische Design Eigenschaften, wie 

Track Styles 

 Einige Objekte enthalten mehr als einen Eintrag – Net Classes enthalten Net 

Names und Track Styles 
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Pad Styles 

 Pad Styles werden Padstacks definiert 

 Mit  ‘By Layer’ werden Pad Ausnahmen erzeugt (unterschiedliche Padform 

und/oder -größe auf unterschiedlichen Lagen) 

 

 Pad Style Edit Dialog enthält die vollständige Pad Definition 

 

 Pad Ausnahmen werden ‘innerhalb’ des Padstack gezeigt, der die Ausnahmenlage 

zeigt 
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Net Classes 

 Net Classes enthalten einen Namen, einen Net Name, Track Styles und Via Styles 

 

 

 Ein zusätzlicher Abstand kann als Guard Space eingestellt werden 

 Der Guard Space Wert wird auf das gesamte Netz angewandt, wird aber auf jede 

individuelle Spacing Regel aufaddiert, zum Beispiel Pad – Pad, Pad – Track, 

Track – Track, und so weiter.  
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Layers 

 In diesem Dialog können alle Layer Types definiert werden 

 Layers und Layer Classes sind für die Konstruktion des Board essentiell 

 Layer Classes definieren, wie die Lage verwendet wird 

 

 

Layer Class 

 Layer Class definiert, wie die Lage verwendet, angezeigt und ausgegeben 

(geplottet) wird 
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Materials 

 Der Materials Dialog wird zur Definition der Materialien des Boards verwendet 

 Er kann alle Materialtypen enthalten, die für die Konstruktion verwendet werden 

 Es kann eine Materialstärke vorgegeben werden 

 

Layer Spans 

Lagenspannen (Start- und Ziel-Lage) für sequentielle Bohrungen werden im Layer 

Spans Dialog festgelegt 

 

Spacing Rules 

Spacing Rules werden zum Einstellen der Abstandsregeln im PCB verwendet 

 

Design Rules 

Design Rules definieren Regeln außerhalb der Spacing und Net Class Regeln 
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DFM/DFT Rules 

 DFM/DFT Rules (Design For Manufacture/Design For Testability) definieren 

weitere Regeln außerhalb der Spacing und Net Class Regeln 

 

Net Class Rules 

Net Class Rules können im Schaltplaneditor definiert werden und in das PCB 

übertragen werden 
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Kapitel 4. Schaltplan Design 

Starten eines neuen Design 

 Starten Sie ein neues Schaltplan Design mit File   New  

 

 Es kann schon voreingestellte Technology und Profile Files enthalten 

 

 Technology Files werden für die Festlegung der Designregeln verwendet 

 Profile Files können zum Starten des Erst-Designs verwendet werden, diese Files 

enthalten Design Objekte wie den Zeichnungsrahmen 

 

 

Hinzufügen von Komponenten 

 Wenn Bauteile hinzugefügt werden, beachten Sie bitte, dass Bauteilinstanzen aus 

der Bibliothek, die im Design verwendet werden Components heißen 

 Für ein Symbol, das im Schaltplaneditor verwendet wird, muss eine Part 

Definition bestehen 

Verwenden von Insert Component 

 Verwenden Sie den Insert Component Dialog oder die Option aus der Toolbar 

 Schalten Sie Preview und Schematic&PCB an, um eine Vorschau der Komponeten 

zu sehen 
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 Hinzufügen der Komponente zum Design oder in die Component Bin 

 Mit Look In, Filter und No.Pins kann die Suche eingeschränkt werden 

 Alternative Footprints, Symbole und Gatter können vorgewählt werden 

 
 

 Mit Find lässt sich die Suche weiter einschränken 
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Hinzufügen von Steckern (Connectors) 

Verwenden von Insert Connector 

 Connectors sind spezielle Parts (erzeugt als Connectors im Part Editor) 

 Der Insert Connector Dialog zeigt nur die Connector Parts 

 

 

 

 ‘Normal’ Parts, die ein Einfach- oder Mehrfach-Gatter besitzen, sind nicht 

beinhaltet 

 Als spezieller Parttyp der Connectors, verwendet es ein SCM Symbol für jeden 

Pin des Parts  

Selektieren & Bewegen von Objekten 

 Objekte können bewegt werden, ohne in einem speziellen Modus zu sein. 

 

 Single Select – für einzelne Objekte oder Segmente 

 Maus-ziehen – Aufnehmen und ziehen bewegt ein Objekt, inklusive der Segment 

Enden 

 CTRL Select – Verwendung von STRG modifiziert die Auswahl 

 Extended Shift Select – Verwendung von SHIFT erweitert die Auswahl 

 STRG SHIFT Select – erweitert und modifiziert die Auswahl 

 Frame / Polygon Select – Diese beiden Modi sind über das RMT Menü 

erreichbar, wenn vorher in einen freien Raum geklickt wird 
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 Ziehen der Maus (bei gedrückter linker Maustaste) in freiem Raum aktiviert 

Frame Select 

 Auto Select – Dieser Modus ist über das Edit Menü verfügbar 

 Auto Select ermöglicht die schnelle Selektion von Objekten durch einen einzelnen 

Mausklick 

 Path Select – Ziehen entlang eines Objektes (mit gedrückter linker Maustaste) um 

den Teil eines Objektes zu selektieren (kann im Options Dialog aktiviert werden) 

 

Zyklische Auswahl 

 Verwenden Sie  <N> für die Auswahl des nächsten Objekts 

 

Move Modi 

Rotate und Mirror sind verfügbar auf Shortcuts, Menü Options, Toolbar Options 

 Rotate (drehen) – Shortcut <R> 

 Mirror (spiegeln) – Shortcut <M> 

 Mirror im Schaltplan spiegelt das Objekt über seine zentrale X-Achse 

 

 Gespiegelter und gedrehter Text kann so definiert werden, das er lesbar bleibt 

(Design Settings  General) 

 

 Für die Objektpositionierung sind die Position, Winkel (Angle) und der 

‚gespiegelt’-Status (Mirrored) in den Properties verfügbar 

 

Verbindungen hinzufügen 

Verbindungen (Connections) können auf mehrere Arten in ein Design eingefügt 

werden: 

 Verwendung des Insert Connection Modus 

 Doppelklick auf einen Pin oder einem freien Bereich 

 Bewegen einer Komponente, so dass der Pin der Komponente den Pin einer 

anderen Komponente berührt (setzt voraus, dass der Auto Weld On Drop Befehl 

in den Options  Interaction  Move gesetzt ist). 

 Ist ein Pin angeschlossen, verschwindet das Kreuz auf dem Pin 
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 Verbindungen können im freien Raum begonnen und beendet werden (unfinished 

connections)  

 Der Insert Connection Modus wird für T-Verbindungen verwendet 

 Der Doppelklick kann als eine Schnellfunktion, zum Hinzufügen einer 

Verbindung, verwendet werden 

 Connection Styles werden im Technology File definiert, aber der anfängliche 

Connection Style wird aus dem Menü Design Settings > Defaults > Connection 

entnommen 

 

 

Verbindungen abschliessen 

Wenn eine Verbindung hinzugefügt wird kann es sein, das sie auf einem Objekt enden 

soll, das noch gar nicht im Design vorhanden ist. 

 Unvollständige Verbindungen können zu einem späteren Zeitpunkt vollendet 

werden 

 Wenn eine Verbindung hinzugefügt wird, können Sie das RMT Menü verwenden, 

um ein passendes Objekt auszuwählen 

 

 Wählen Sie aus der Liste der verfügbaren Doc Symbol Typen den gewünschten 

aus 

 Jeder Type ist im Design Settings  Defaults Dialog vordefiniert 

 

Netze benennen 

 Ändern des Netznamens mit RMT Menü und Change Name oder Taste <F2>  

 

 Das Default Format von Netznamen wird im Design Settings  Naming Dialog 

eingestellt 
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Net Colours 

 Die Farbe von unfertigen (unfinished) Netzen kann im Colours  Highlights 

Dialog eingestellt werden 

 

Netze auftrennen 

 Aus dem RMT Menü, verwenden Sie Remove From Net 

 

 Zwei Hälften eines Netzes haben den selben Netznamen 

 Verwenden Sie Change Net <F2> und aktivieren Sie den Change Name Of 

Subnet Only Schalter 

Verbindung ablösen 

 Disconnect Con End wird verwendet, um eine Verbindung von einem Pin auf 

einen anderen zu verschieben 

 Diese Option ist nur verfügbar, wenn eine Verbindung editiert wird 

 Der Befehl findet sich im RMT Menü 

 

 Ein Ende der Verbindung wird vom Objekt abgelöst 

 Die Richtung des dynamischen Endes kann über das RMT Menü  Change 

Segments  Reverse Edit Direction umgeschaltet werden 
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Verbindungen prüfen 

Der Status der Verbindungen kann zu jeder Zeit geprüft werden 

 Verwenden Sie die Online oder die ‘batch’ Option Electrical Rules Checking  

 Verwenden Sie den Nets Report, Power and Ground Report und den Ungated 

Pins Report im Output  Reports Menü 

 Um Verbindungen zu finden, die nicht angeschlossen sind, aber optisch 

angeschlossen erscheinen, verwenden Sie den Unfinished Items Report 

 Sie können die Anzeige dieser unvollendeten Objekte auch unter Colours  

Highlights  Unfinished festlegen 

Dokumentationssymbole 

 Schematic Doc Symbols werden verwendet, um spezielle Design Objekte 

hinzuzufügen 

 Verwendet für: Block Ports, Block Symbols, Page links, Testpoints, Signal 

References (wie Power & Ground Symbole, Seiten Referenzen, und so weiter) 

 Doc Symbols haben keine Part Definition und sie werden nicht in das PCB Design 

übertragen (mit Ausnahme der Testpunkte) 

 Sie können für spezielle Design Erfordernisse verwendet werden, oder einfach zur 

Annotation des Design 

Verwenden ‘allgemeiner’ Doc Symbols 

 General Doc Symbols können jede Art von Documentation Shape, electrical Pin, 

Text und Attribut enthalten 

 Sie sollten Doc Symbole unter Verwendung von Insert  Doc Symbol aus der 

Bibliothek hinzufügen 

  

 Doc Symbole können aus dem Insert Menü oder der Werkzeugleiste eingefügt 

werden 

Signal Referenzen 

 Signal Referenzen können aus unterschiedlichen Gründen eingefügt werden 

 Sie können in Form von Cross Sheet Signal References, Power & Ground 

Symbolen oder einfacher Signal Referenzen auftreten 

Power und Ground Symbole 

 Power und Ground Symbole werden im Schaltplan verwendet, um die Verbindung 

mit einer Versorgungsquelle zu definieren 
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 Signal Referenzen werden aus Dokumentationsgründen verwendet und werden 

nicht ins PCB übertragen 

 Die von ihnen repräsentierten Signale werden während der Übertragung an das 

PCB miteinander verbunden 

 

 

 Der Netz Type und Netzname können festgelegt werden 

 Verwenden Sie Insert  Signal Reference, um dem Design eine Signal Referenz 

hinzuzufügen 

 Wenn die Netz Klasse und der Netzname festgelegt sind, wählen Sie die Option 

aus dem Dialog: 

 

Cross Sheet Referenzen 

 Das vorher beschriebene Prinzip wird auf normale Referenzen angewendet, 

welche für die inter-sheet oder Cross sheet Notation verwendet werden 

 Die Hauptausnahme ist, dass der im Symbol verwendete Pin keine vordefinierte 

Netzklasse oder Netznamen hat 

 Der Netzname wird bei Gebrauch auf den Pin angewendet 

 Wenn Signal Referenzen im Doc Symbol Editor erzeugt werden, ist das 

Netznamen Attribut zur Verwendung vordefiniert 

 

 Eine Signalreferenz im Schaltplan kann wie folgt aussehen: 

 

Testpunkte 

 Wie auch  Signalreferenzen, sind Testpunkte grundlegende Elemente 

 Während der Erstellung im Doc Symbol Editor, wird das Testpoint Name Attribut 

zur Verwendung vordefiniert 

 

 Dies wird verwendet wenn die Insert Testpoint Option selektiert ist 
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 Wird auch verwendet wenn eine Verbindung auf einem Testpunkt startet oder 

endet 

Page Links 

 Mit Page Links werden Verweise eines Signals auf eine andere Seite eingefügt. 

Sie wirken wie ein Hyperlink. Durch das Verwenden eines Page Links, wechseln 

Sie direkt auf die andere Seite 

 

 Page Links werden oft verwendet um ein Netz zu verbinden, das eine Seite 

verlässt und auf einer anderen Seite weiterführt 

Hinzufügen von Page Links 

 Ein Page Link wird mit dem <Page Link> Attribut realisiert 

 Der Wert des Attributs ist der Name der Seite auf die der Link verweist 

 Durch einen Doppelklick auf dieses Attribut wird diese Seite geöffnet 

 Verwenden Sie die Insert  Attribute Option und wählen Sie <Page Link> aus 

der Liste der Attribut Namen und geben Sie den benötigten Seitennamen ein, oder: 

 Wählen Sie das Objekt zu dem Sie den Link hinzufügen wollen, oder:  

 Wählen Sie gar nichts, wenn der Link direkt zu der Schaltplanseite gehören soll. 

 Aus dem RMT Menü verwenden Sie die Add Page Link Option 

 

 Wählen Sie aus der Liste der Namen der vorhandenen Seiten, oder geben Sie einen 

neuen Seitennamen ein, von der Seite auf die verlinkt werden soll 

 

Sternpunkte (Star Points) 

Sternpunkte werden verwendet, um mehrere Netze in einem gemeinsamen Punkt zu 

verbinden (zum Beispiel GND, AGND, DGND) 

 Sie können einfache oder komplexe Formen sein 

 Wenn er ins PCB übertragen wird, wird ein PCB Star Point Symbol eingefügt 
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Elektrische Regelprüfung 

 Electrical Rule Checking (ERC) ist ein Prüfmechanismus, welcher es erlaubt Pin 

Type Regeln einzustellen und diese zu Prüfen 

 Verwenden Sie die Online oder die Batch-Option 

  

Attribute hinzufügen 

 Attribute werden mit Insert Attribute hinzugefügt, oder: 

 Für unvollständige Attribute, verwenden Sie Insert Attribute Position  

 

 Wenn unvollständige Attribute definiert werden, wird das Value Feld auf <Place 

Holder Only> gesetzt 

 Es können vorhandene System Attribute verwendet werden, zum Beispiel Date, 

Title, und so weiter 
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Berichte (Reports) 

 Reports (im Output Menü) werden verwendet, um Standardberichte auszugeben  

 

 Die Report Maker Option wird zur Programmierung eigener Berichte verwendet  

Netzlisten 

 Netzlisten können mit der Export Netlist Option im File Menü exportiert werden 

 

 Der Report Maker kann anwenderspezifische Netzlisten exportieren 
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Report Maker 

Der Report Maker wird verwendet, um anwenderspezifische Berichte, Stücklisten und 

Netzlisten zu erstellen 

 Extrem konfigurierbar und kann die meisten Design-Elemente auflisten 

  

Schaltplan drucken 

 Es gibt zwei Möglichkeiten Ausdrucke zu erzeugen - Print und CAM Plot 

 Die Standard Windows Print Option druckt Ihre aktuelle Designansicht aus 

(Bildschirmdarstellung): automatisch skaliert und rotiert, um die eingestellte 

Papiergröße bestmöglich auszufüllen 

 Die CAM/Plot Option bietet eine ausgefeiltere Schnittstelle 

 CAM Plot verwendet eine regelbasierte Methode, die mehr Kontrolle und 

Konsistenz bei der Positionierung der Inhalte des Ausdrucks erlaubt 

 Die CAM Plot Option ist die empfohlene Methode 

 Plot Position, Vergrößerung, usw. Werden im CAM Plots Dialog eingestellt 

 

 Weitere Information zum CAM/Plot finden Sie im Kapitel  ‚Ausgabe des Design’ 
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Kapitel 5. PCB Design 

Übertragen zum PCB (Forward Annotation) 
Der Befehl Translate To PCB erstellt aus dem Schaltplan eine Netzliste und 

überträgt diese in eine neue PCB Datei.  

 Starten Sie das Design aus Pulsonix Schaltplan durch Verwendung von Tools > 

Translate to PCB 

 

 Der Translate to PCB Dialog erlaubt Ihnen den Namen des PCB Designs zu 

definieren, und optional das zu verwendende PCB Technology File und PCB 

Profile File festzulegen 

 Die Technologie enthält Voreinstellungen, wie die Masseinheit, Raster, Farben, 

Lagendefinitionen und –aufbau, Netzklassen und Regeln, usw. 

 Ein Profile kann enthalten: Board-Outline, Montagebohrungen, Bemassungen, 

Bestückungstext und Bohrtabelle, einen Zeichnungsrahmen, vordefinierte, 

vorplatzierte Bauteile, Stecket, und so weiter 

 Nach dem Translate to PCB befindet sich das Projekt nur virtuell im 

Arbeitsspeicher. Bitte führen Sie Save aus, um es zu Speichern und in den Backup 

Lauf einzugliedern  

Komponenten Vorplatzierung im PCB 

 Profile Files können als Teil des Translate to PCB Mechanismus verwendet 

werden 

 Wenn der Schaltplan eine Komponente mit dem selben Namen verwendet, wie 

eine der vorplatzierten Komponenten im Profile, dann wird die vorplatzierte 

Komponente verwendet 

 Jede Komponente Im Profile, die keine Entsprechung im Schaltplan hat, wird 

verworfen (gelöscht) 

Die Form des Boards anlegen (Insert Board) 

Um ein Board anzulegen werden Elemente wie Board Outline, Mounting Holes, 

Areas, Cutouts und Texte angelegt; oder es wird ein vorbereitetes Board verwendet, 

das als Profile gespeichert ist 

Es gibt verschiedene Methoden eine Board Outline zu erstellen: 

1. Manuelle Erstellung unter Verwendung des Menüs Insert > Board. 

Dabei können Funktionen wie Construction Lines die Arbeit 

unterstützen. 

2. Laden eines bestehenden Board Profile 

3. Import und Extraktion eines Boards aus einem anderen PCB System 

4. Import eines DXF File aus einem mechanischen System 

 Board Outlines können jede beliebige Form haben, inklusive runde Formen 
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 Wenn Sie Ausbrüche (Cutouts) benötigen, verwenden Sie die Insert Cutout 

Option, um ‘reale’ Ausbrüche innerhalb der Board Outline zu erstellen 

 

Montagebohrungen (Mounting Holes) 

 Mounting Holes sind Montagebohrungen an denen das Board mechanisch 

befestigt wird 

 Mounting Holes können auch schon in der Bibliothek an Bauteilen mit Schraub-

befestigungen definiert werden 

 Verwenden Sie Insert Mounting Hole aus dem Insert Menü 

 Ein Mounting Hole kann einen Netznamen erhalten und elektrisch angeschlossen 

werden 

 

 Mounting Holes werden in einem Footprint nicht als Pad gezählt 

 Soll das Bohrloch keinen Restring besitzen, muss die Bohrung größer definiert 

sein als der Pad – in diesem Fall wird eine Warnung ausgegeben 

 Mounting Holes haben ihre eigenen Abstandsregeln (Spacing Rules) in der 

Technology unter Spacing Rules 

Profile Files 

 Profile Files sind eigenständige Dateien 

 Profile Files aus Schaltplan und aus PCB sind nicht identisch 

 Profile Files können enthalten: 

- Board Outline – Die Form und Größe, die für die Herstellung nötig ist 

- Mounting Holes 

- Bemassungen 

- Bestückungs-Text und Bohrtabelle 

- Zeichnungsrahmen 

- Vordefinierte, vorplatzierte Komponenten, z.B. Stecker 

- Ursprungskoordinaten (Origins)  

- Regelbereiche (Areas), z.Bsp. Sperrflächen (Keep Outs) 

- Geometrien von berechneten Kupferflächen (Copper Pour Templates) 

- Attribute 
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Component Bin 
Die Component Bin im PCB wird für unplatzierte Komponenten verwendet 

 

Komponenten aus der Bin verschieben 

Komponenten können aus der Bin auf unterschiedliche Weise platziert werden 

 Durch ziehen der Komponente aus der Bin ins Design 

 Mittels RMT > Move From Bin 

 Durch den Place Around Board Befehl 

 Durch die Auto Place Option (Teil des Autorouters) 

Komponenten in die Bin verschieben 

Komponenten können in die Bin verschoben werden 

 Über RMT > Move To Bin 

 Aus der Insert Component Option 

 Aus der Auto Place Option mit Move To Comp Bin (Teil des Autorouters) 

 Durch verwenden der Translate to PCB Option im Schaltplan 

 

Erstplatzierung von Komponenten 
Es gibt eine Anzahl an Platzierungsoptionen: 

 Automatisches Ablegen der Komponenten während der Forward Annotation 

(Translate to PCB)  

 Komponenten um das Board herum platzieren (Place Around Board) 

 Manuelles Platzieren 

 Platzieren aus der Component Bin 

 Auto Platzierer (Teil des Autorouters) 

Place Around Board  

Komponenten können entlang der Board Outline abgelegt werden 

 Die Komponenten werden, nach Part-Namen gruppiert, rund um das Board 

abgelegt 

 Diese Funktion benötigt eine Board Outline! 
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Manuelle Platzierung 

 Pulsonix verwendet die Standard Windows Interaktion 

 Greifen und ziehen Sie die Komponenten an Ihren Platz 

 Die Starteinstellungen für die Interaktion mit Komponenten finden Sie im Options 

Dialog 

 Es kann auch der Properties Dialog einer ausgewählten Komponente verwendet 

werden 

 Während des Bewegungs- und Auswahl –Modus sind viele spezielle Optionen im 

RMT Menü verfügbar 

   

 Es gibt dynamische Optimierungen 

 Komponenten oder Footprints werden in der Bibliothek editiert 

 Die Komponente wird dann mit Reload Component im Design aktualisiert 

 Verschieben Sie Komponenten in die Bin 

 Kopieren Sie Komponenten (nicht im PCB Safe Modus) 
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 Die Raster Definition wird aus dem Grids Dialog genommen Ändern Sie das 

Platzierungsraster im RMT Menü 

 

 Abstandsregeln für Komponenten sind in der Technology unter Spacing Rules 

definiert 

 

 Der Minimum Space wird vom DRC verwendet, um überlappende Komponenten 

zu finden 

 Der Optimum Space wird beim manuellen Push und vom Autoplacer verwendet  

Verbindungen (Connections) 

 Connections zeigen die Punkt-zu-Punkt Verbindungen der Netzliste an 

 Connections tragen eine Anzahl von Eigenschaften (Properties): 

- Einen anwender- oder systemdefinierten Netzname 

- Eine Netzklasse, welche weitere Eigenschaften enthält: 

Leiterbahnbreite (Track style), Via-Typ (Via style), Abstand (Spacing), ggfs. 

Längenregeln, usw. 

 Connections können an jedes elektrische Objekt angeschlossen sein, inklusive: 

- Pads 

- freie Pads  

- Montagebohrungen 

- Testpunkte 

- Vias 

- Leiterbahnen 

- Kupfer 

- Bereiche für berechnetes Kupfer 

- Masse-Sternpunkte 

 Die Farben der Verbindungen können im Colours Dialog geändert werden 

 Mit SHIFT + O werden die Verbindungen optimiert 
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 Die Grundeinstellungen für Connections finden sich in den Design Settings > 

Nets oder sie kommen aus dem Schaltplan 

 

 Gatter und Pin Tausch kann verwendet werden, sofern die Regeln in der Parts 

Bibliothek definiert sind 

Verbindungen und Leiterbahnen editieren 

 Mit einem Doppelklick auf die Verbindung starten Sie die Leiterbahn 

 Verwenden Sie den Edit Track Modus 

 Editiereinstellungen sind im RMT Menü verfügbar 

 

 Change Segments enthält wichtige Optionen für das Routing 

 

 Der Wechsel des Rasters (Change Grid) ist auch im RMT Menü und über Hotkeys 

verfügbar 
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 Die Optionen sind für selektierte Leiterbahnen verfügbar 

 

Leiterbahnen manuell entflechten 

Um damit anzufangen eine Verbindung in eine Leiterbahn umzusetzen 

 doppelklicken Sie auf eine Verbindung oder 

 Selektieren Sie die Verbindung und wählen Edit aus dem RMT Menü, oder 

 Wählen Sie Insert Track, selektieren anschließend die Verbindung oder die 

Leiterbahn und fügen die Leiterbahn ein 

 Leiterbahnen die ohne Netzliste in ein Design eingefügt werden, erzeugen einen 

Netzlisteneintrag (Gesperrt im PCB Safe Modus) 

       

  Vorher     Nachher 

 Sobald Sie mit dem Routen angefangen haben stehen Ihnen folgende Befehle zum 

Editieren zur Verfügung:  

- Einzel-Click - fügt eine Ecke ein und erlaubt das Ändern der Richtung 

- Change Layer <L>, gefolgt von <Enter> wechselt die aktive Lage auf die 

alternative Lage (Definition in Setup > Design Setings > Track). Es kann 

auch eine bestimmte Ziellage ausgewählt werden. 

- STRG-Click fügt ein Via ein und wechselt die Lage 

- Change Style <S>, gefolgt von <Enter> ändert den Leiterbahn Style auf den 

alternativen Wert, der in der Netzklasse definiert ist 

- RMT > Fatten Track (Leiterbahnen dicker) ist für selektierte Leitungen 

verfügbar 

- Was ein Doppelklick während des Editierens einer Leitung verursacht kann in 

Options > Edit Track definiert werden.  

- Route to Finish :  Leiterbahn automatisch zu Ende routen 
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- Change Layer : Einfügen eines Via und Wechsel auf alternative Lage 

- Finish on Via : Setzen eines Vias und Freigabe des Cursor 

- Finish here :  Absetzen der Leiterbahn und Freigabe des Cursor 

- Mit Shift-M werden die vorgeschlagenen Leiterbahnsegmente getauscht : Aus 

orthogonal-Diagonal wird diagonal-orthogonal und umgekehrt 

   

- Shift-Klick erzeugt immer eine Leiterbahnecke 

- Wenn eine Leiterbahn über einem anderen Objekt ist und der Finish Here (F) 

Anzeiger erscheint, fügt Shift-Klick eine Ecke ein und endet noch nicht 

Optionen einstellen 

Verwenden Sie Options  Edit Track, um die Editieroptionen voreinzustellen 
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Online DRC und Anzeige der Abstandsregeln 

 Der Online DRC ist während aller interaktiver Tätigkeiten verfügbar 

 Alle interaktiven Modi werden gegen die Spacing Rules gecheckt, die im 

Technology > Spacing Rules Dialog definiert sind 

 Wenn die Online DRC Box angehakt ist, wird die Prüfung bis zu einem gewissen 

Grad auch während des manuellen Bearbeitens von Objekten durchgeführt 

  Es gibt eine Show Design Rule Clearance Option, welche automatisch die 

Abstandsregeln um statische Objekte anzeigt 

 

 

 Der Abstand ändert die Farbe, um den Status der Objekte anzuzeigen. Die 

Warnfarbe wird im Colours Dialog > Highlights > Clearances eingestellt 

 

 
 

Verwenden von Shapes 
Shapes (Formen) werden in Pulsonix für eine Menge von Design Objekten verwendet. 

 Shapes sind lagenspezifisch.  

 Die Wirkung der Shapes ist objektabhängig.  

 Bei der Erstellung von Shapes können Construction Lines verwendet werden. 

Shape Typen 

 Board Leiterplattenkontur (Aussenkante) 

 Copper feste Kupferflächen (werden nicht berechnet) 

 Shapes Formen für Dokumentationszwecke (zum Beispiel Rahmen) 

 Areas  Bereiche mit eigenen Regeln (Sperrbereiche, Ausfräsungen, usw) 

 Templates berechnete Kupferflächen 

Shape Eigenschaften 

 Für jeden Shape-Typ gibt es charakteristische Eigenschaften 

 Alle Shapes können offen (Polygonlinie) oder geschlossen (Polygonfläche) sein 
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 Geschlossene Schapes können leer, gefüllt oder schraffiert (hatched) sein 

Die verfügbaren Shapes 

 Jedes Shape kann über das Insert Menü eingefügt werden 

- Polygonflächen und Polygonlinien 

- Rechtecke und Quadrate 

- Kreise 

- Dreiecke 

 Wenn ein Shape als geschlossen (Closed) definiert ist, kann es außerdem gefüllt 

(Filled) und schraffiert (Hatched) sein, aber er kann nicht offen (Open) und 

gefüllt/schraffiert sein 

 

 Ein gefülltes Shape kann weiterhin eine beliebige Anzahl an Freiflächen (Cutouts) 

besitzen 

 Line Styles können durchgehend (solid), gepunktet (dotted), gestrichelt (dashed) 

oder eine Kombination von gepunktet und gestrichelt sein 

 

 Der Schraffurstil wird über das Styles Setup im Technologie Dialog unter Hatch 

Style definiert. Der Style kann sowohl Hatched als auch Cross Hatched sein 

Freiflächen (Cutouts) 

 Cutouts werden innerhalb eines Shapes verwendet, um eine Freifläche oder 

Ausfräsung zu definieren 

 Andere Funktionen in Pulsonix verstehen den Unterschied zwischen Shapes und 

Cutouts 

 Cutouts sind Shapes zugeordnet, sie werden mit diesen selektiert und bewegen 

sich mit ihnen, wenn die Shapes verschoben werden 

 Cutouts sind geschlossene Formen und können auf elektrischen- und auf 

Dokumentations-Shapes verwendet werden 

 Das Cutout kann die Außenlinie seines Shapes nicht übertreten 
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Kupfer Typen 

Festes Kupfer (Basic Copper Shapes) 

 Feste Kupferflächen können in ein Design eingefügt werden 

 Verwenden Sie die Insert Copper Shape Option 

 Diese Shapes sind kein berechnetes Kupfer und umfließen daher auch keine Pads 

oder anderen Hindernisse 

 Dem Kupfer kann ein Netzname zugewiesen werden 

 Die Styles und Lagen können geändert werden. Die Lage muss eine elektrische 

Lage sein 

Fliessendes Kupfer (Copper Pour) 

 Fliessendes Kupfer wird verwendet, um Flächen im PCB Layout mit Kupfer zu 

fluten 

 Der geflutete Bereich kann zusätzlich an ein Netz angeschlossen werden 

 Im Gegensatz zu Insert Copper, umfließt fliessendes Kupfer Hindernisse, wie Pads 

oder fremde Leitungen 

Fliessendes Kupfer anwenden 

Das Prinzip folgt diesem Weg: 

 Zeichnen eines Shapes vom Typ Template 

 Einfügen eines Netznamen für die Kupferfläche 

 ‘Fluten’ des Kupfers in dieser Fläche 

 Unterschiedliche Eigenschaften des Kupfers können über Technology > 

DFM/DFT Rules gesteuert werden 

Einstellungen im Technology Dialog 

 Kupfer verwendet seine eigenen Parameter für die Isolationsabstände 

 Sie werden unter Technology > Spacing Rules definiert 

 

 Die Abstände in der Kupferfläche werden über die Regeln in Technology > 

DFM/DFT festgelegt 
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Templates 

 Templates sind lagenspezifisch 

 Der Line Style eines Template bestimmt die Dicke (Blende) des verwendeten 

Kupfers 

 Der Line Style bestimmt außerdem mit welcher Mindestbreite zwischen 

Hindernissen (Pads, Vias, Leiterbahnen) hindurchgefahren wird 

 Wenn das Kupfer mit einem Netz belegt werden soll, kann der Netzname dem 

Template vor der Kupferberechnung zugeordnet werden 

 Mit RMT > Pour Copper oder Utilities > Pour Copper werden definierte 

Templates geflutet 

 Berechnetes Kupfer wird mit Clear Template, aus dem RMT oder Utilities Menü, 

entfernt 

 

 Die Regeln für ‚totes’ und für schraffiertes Kupfer finden sich in der Technology 

unter DFM/DFT Rules 

Synchronisieren des Design 

 Die Synchronise Designs Option wird zum Vergleichen von Schaltplan und PCB 

Design verwendet 

 Jeder gefundene Unterschied kann automatisch in das PCB Design übernommen 

werden (Forward Annotation) 

 Im PCB Layout gefundene Änderungen (Pin- und Gate-Swap, Änderungen der 

Referenz Bezeichner) können automatisch in den Schaltplan übertragen werden 

(Back Annotation) 

 Synchronise Designs kann jederzeit gestartet werden, um zu Prüfen ob die 

Netzlisten identisch sind 

 Wenn Unterschiede gefunden werden öffnet sich ein Dialog, der einen Report der 

Änderungen und die Möglichkeit zur Übernahme der Änderungen anbietet 

 Normalerweise werden Sie die zusammengehörenden Schaltplan und PCB Layout 

vergleichen, Sie können bei Bedarf aber auch ein anderes Design angeben 

 Eine große Anzahl von Änderungen in der Netzliste führt zu großen Änderungen 

im PCB 

 Elektrische Objekte (Bauteile und Netze), die aus dem Schaltplan entfernt wurden, 

werden auch aus dem PCB entfernt.  
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Design Rules Check (DRC) 

 Die Design Regelprüfung (Design Rules Check) wird verwendet, um zu prüfen 

das keine Abstandsregeln, die in der Technology definiert sind, verletzt wurden 

 Es werden auch andere definierte Regeln geprüft  

 Fehler werden im Design durch Error Marker angezeigt 

  

DRC Error Browser 

 Der DRC Error Browser wird verwendet, um die Design Error Marker anzuzeigen 

 Die Liste wird in einem aktiven Browser angezeigt, die durch einen Doppelklick 

auf den Fehler in der Liste, den Fehler im Design lokalisiert 

 

 Der Browser wurde kategorisiert, um dadurch eine Rangfolge der Fehler zu 

erstellen, startend mit dem Design (DRC Errors), dann Lagen, dann Fehlertyp, 

zum Schluss den Markern selbst 
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Bemaßungen (Dimensions) 

 Insert Dimension wird zum Bemaßen der Designobjekte, oder der Abstände 

zwischen ihnen, verwendet 

 Es zeigt (in Form von Bemaßungspfeilen) die Länge von Objekten, Radien von 

Rundungen und Winkel zwischen Linien an 

 Es gibt fünf grundlegende Bemaßungstypen in der Insert Dimension Option: 

horizontal, vertikal, freie Ausrichtung, Radius und Winkel 

 

Standard Einstellungen der Bemaßungen 

 Die Standardeinstellungen der Bemaßungen werden in den Design Settings unter 

Dimension und Dimension Units definiert  

 Dadurch wird das Aussehen der Bemaßungen festgelegt 
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Kapitel 6. Ausgabe des Design 

 Verwenden Sie die Print Option aus dem File Menü, um das Design genau so 

auszudrucken, wie es auf dem Bildschirm dargestellt wird 

 Print druckt auf dem ausgewählten Windows Drucker und passt das Design 

automatisch an die Papiergröße an 

 Die CAM Plot Option aus dem Output Menü ist für anwenderdefinierte 

Ausdrucke und Plots auf ein festgelegtes Gerät, unter Verwendung ausgewählter 

Parameter 

 Unterstützte Ausgabeformate sind: 

- Gerber 274-D und 274-X (Standard und Extended Gerber Format)  

- Numerisch gesteuerte Bohrdaten (Excellon, NC Drill) 

- PDF 

- Windows Printer Plots verwenden jeden installierten Windows Druckertreiber 

- HPGL Stift-Plotter 

- Anwenderdefinierte Reports 

 Plots sind verfügbar für: 

- Top, Bottom und elektrische Innenlagen 

- Bestückungsdruck-Lagen (Silkscreen) 

- Lötstop-Lagen (Solderresist) 

- Lötpasten-Lagen (Solder paste masks) 

- Kupfer und Versorgungslagen (Copper und Powerplanes) 

- Kombinierte Plots (zum Beispiel für eingebettete Leitungen auf 

Versorgungslagen) 

- Herstellungs-, Bestückungspläne (Assembly und Manufacturing) 

- Drillsymbol Zeichnung und Tabelle 

- Bohrdaten (NC Drilling Files) 

- Ausgabe Format Daten (Output Format Files) 

Die Auto Generate Plots Funktion 

 Wird verwendet, um eine Voreinstellung für Plots automatisch zu konfigurieren 

 Sie können den Standard Plot Modus für jede Lage und Lagenkombination 

auswählen 

 

 Sind Sie einmal im CAM/Plot Dialog, können Sie diese Plot-Typen editieren 
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Der CAM Plot Dialog 

 Der Dialog selbst ist in drei Sektionen geteilt, um die Plots zu definieren 

 

 Plot Preview wird verwendet, um eine Vorschau des endgültigen Plots anzuzeigen 

 CAM Plots wird verwendet, um die Charakteristiken des Plots einzustellen (zum 

Beispiel Vergrößerungen) 

 Plot Settings wird verwendet um den Plotter oder Printer einzustellen 

 Mit dem Run Schalter werden die ausgewählten Plots erzeugt 

 

 Mit Apply werden alle Änderungen im Dialog gespeichert/übernommen, ohne den 

Dialog zu verlassen 

 Mit Close oder Cancel wird der Dialog verlassen ohne Änderungen zu 

übernehmen 

 Der Close Schalter wird anstelle von Cancel gezeigt, wenn vorher der  Apply 

Schalter verwendet wurde. Er schließt ebenfalls den Dialog 

CAM Plots 

 Der CAM Plots Dialog wird zum Einstellen des Plots für die Ausgabe verwendet  

 Diese Seite kann automatisch durch die Auto Gen Option erstellt werden 

 

 Die Tabelle zeigt die Optionen, die für jeden einzelnen Plot ausgewählt sind 
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 Der Edit Schalter erlaubt das Editieren von Plot-Typen 

 

 Add to Plot kombiniert mehrerer Lagen in einen Plot. Dabei kann jede Lage 

einzeln verschoben, gespiegelt und skaliert werden 

 

 

 Step&Repeat erzeugt einen Mehrfachnutzen 
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Plot Preview 

 Dieser Dialog zeigt eine Vorschau des Plots 

 

 Jeder ausgewählte Plot wird im Preview Fenster angezeigt 

 Eine Zusammenfassung der Plot Informationen wird  auch auf dieser Seite gezeigt 

 Wird in die Vorschau geklickt, kann mit dem Scrollrad gezoomt werden. 

 Der rote Rahmen gibt die Größe des Films oder Papierformat an 

 Der blaue Rahmen zeigt die Größe des auszudruckenden Bereiches 

Plot Settings 

 In den Plot Settings wird der Drucker/Plotter eingestellt 

 Hier werden auch der Speicherort für die Ausgabedaten und die Dateinamen 

eingestellt 

 

 In der Output Device Sektion des Dialogs können Sie  die Einstellungen für jedes 

verfügbare Ausgabegerät ansehen und verändern 

 Verwenden Sie die Drop-Down-Liste, um das gewünschte Ausgabegerät 

auszuwählen 

 Eine Zusammenfassung seiner Einstellungen wird angezeigt, mit dem Setup 

Schalter werden die Einstellungen geändert 

 Verwenden Sie Save To File und Load From File um die Geräteeinstellungen zu 

speichern oder nachzuladen 
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Wie werden die Plots gesteuert? 

 Der Inhalt der Plots wird in der Technology im Layers und Layer Classes Dialog 

gesteuert 

 

 Es muss nicht nur die Lage existieren, auch die Layer Class muss die korrekten 

Einstellungen für diese Lage enthalten 

 

 Dieser Dialog steuert außerdem die Bildschirmanzeige der Lagen 
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Bohrzeichnungen (Drill Drawings) 

 Das Drill Sizes Register enthält den Drill Sizes Dialog 

 Drill Sizes ist für den CAM Plot Dialog unter Plot Settings verfügbar 

 Sie können die Bohrdurchmesser mit Buchstaben oder Symbolen assoziieren 

indem Sie die Drill ID beziehungsweise Drill Symbol verwenden 
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Kapitel 7. Arbeiten mit Attributen 

Ein Attribut ist eine Textinformation, die an ein Designobjekt angehängt wird. Es ist 

auch für das Design selbst verfügbar. Einige Attribute werden automatisch an Objekte 

angehängt, wie zum Beispiel Pin-Namen, andere Attribute sind anwenderdefiniert. 

Attribute können angezeigt und gedruckt werden, oder unsichtbar sein, um in Reports 

verwendet zu werden, oder an Drittprogramme weitergegeben werden.  

Ein Attribut hat die folgenden Eigenschaften: 

 Attribute Name – System Attribute sind durch spitze Klammern gekennzeichnet - 

zum Beispiel <Part Name> 

 Alle selbstdefinierten Attribut-Namen sind zusammengefasst und im Technology 

Dialog repräsentiert 

 Attributfarben werden im Colours Dialog eingestellt 

 

 Attribute Value – Dies ist ein Textstring, entweder automatisch oder 

anwenderdefiniert 

 Der Wert kann frei gelassen werden, wenn das Attribut nur zum Markieren eines 

Objektes verwendet wird 

 Attribute Position – Jedes Attribut kann seinen Wert im Design anzeigen, die 

angezeigte Position wird ‘Attribute Position’ genannt  

 Owner – Jedes Attribut ist an ein Objekt gebunden. Das kann ein Objekt innerhalb 

eines Designs sein, ein Objekt innerhalb eines Footprint oder Part, oder angehängt 

an das Design, Footprint oder das Part selbst 

 Attribute können nicht an Texte, andere Attribute, Verbindungen, Leiterbahnen, 

Bemaßungen oder Ursprünge angehängt werden 

 Das Bewegen eines Attributs zeigt gleichzeitig seinen Besitzer  

 Attributen können in der Technology definiert werden 

 Verwenden Sie das Attribute Names Register im Technology Dialog 
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 Sie können wählen ob Attribut Werte, Namen oder beides anzeigen lassen 

Attribut einfügen (Insert Attribute) 

 Verwenden Sie die Insert Attribute Option, wählen Sie dann das Objekt im 

Design 

 Geben Sie einen Attribut Namen und Wert an 

 Platzieren Sie das Attribut interaktiv, wählen Sie seinen Style und Layer  

 

Part Attribute im Part Editor 

 Verwenden Sie den Part Attribute Editor und die Parts und Attributes Seite, um 

Part-Attribute anzulegen 

 

 Das Attribut wird in der Bibliothek mit dem Part gespeichert 

 Part-Attribute werden den ins PCB oder Schaltplan eingefügten Komponenten 

angehängt 

 Part-Attribute können mit lokalen Attributen überschrieben werden 

Hyperlink Attribute 

 Mit der Insert Attribute Option können Sie den Bibliotheks- oder Design-

Objekten Hyperlink-Attribute hinzufügen. Das ist ein eingebautes Attribut mit 

dem Namen <Hyperlink>. 

 Verwenden Sie den Execute Hyperlink Befehl aus dem RMT Menü, Pulsonix 

wird versuchen die zugehörige Anwendung zu öffnen, um den Link zu öffnen 

 Sie können Ordner und Dateinamen angeben oder Internet URLs 
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Kapitel 8. Bibliotheken 

Grundlagen Bibliotheken 

Grundlagen Parts 

 Pulsonix Designs verwenden eine Part Definition, um das Schaltplan-Symbol und 

den PCB Footprint zu verknüpfen. Außerdem enthält die Partdefinition 

bauteilrelevante Informationen, wie Part-Nummer, Wert und weitere Attribute 

(System- und Eigene- Attribute) 

 

 Schematic Doc Symbols und PCB Doc Symbols werden verwendet um das Design 

mit Zusatzinformationen zu versehen 

 Sobald ein Part im Design verwendet wird, wird es Component oder Component 

Instance genannt 

 

Part Definitionen 

Parts können auf unterschiedliche Weise in der Bibliothek definiert werden: 

 Homogene (Einzel-Gatter) Parts, mit oder ohne sichtbaren Versorgungspins, zum 

Beispiel 4000er Serie 

 Heterogene (Mehrfach-Gatter) Parts, mit oder ohne sichtbaren Versorgungspins, 

zum Beispiel 74LS00 

 Ein vollständiges Part verweist sowohl auf das Schaltplansymbol als auch auf den 

PCB Footprint 

 Ein im Schaltplan verwendetes Part kann in das PCB übertragen werden, das Part 

enthält die benötigte Referenz 

 Parts können auch als ‘nur Schaltplan’ (SCM only) oder ‚nur PCB’ (PCB only) 

erstellt werden 

 Associated Parts können einer Parts Definition ebenfalls hinzugefügt werden 

 Parts werden im Schaltplan und im Layout eingefügt 
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Terminologie der Part Definitionen 

 Component – eine Instanz eines Part, sobald es im Design verwendet wird 

 Associated Part – Ein Part das als sekundäres Part zugewiesen wird, aber selbst 

nicht im Design angezeigt wird. Zum Beispiel Schrauben, Muttern, Kühlkörper, 

und so weiter. Diese Parts erscheinen jedoch in der Stückliste 

 Gate – Ein oder mehrere Gatter ergeben die interne Definition eines Part. Ein 

Gatter verweist auf ein Symbol. Ein Gatter und ein Symbol haben eine 1:1 

Beziehung. Mehrfachgatter können auf das gleiche Symbol verweisen. Viele Parts 

sind Einzelgatter, es gibt jeweils ein Gatter und ein Symbol 

 Symbol – Der Name verweist auf das Schaltplansymbol, das im Part verwendet 

wird. Eine grafische Anzeige des Symbols wird im Part Editor gezeigt 

 Symbol Pin – Dies ist die Pin-Reihenfolge, die beim Erzeugen oder Editieren des 

Schaltplansymbols angezeigt wird 

 Pin Name – Das ist der aktuelle Name, der im Design auf dem Pin/Pad erscheint, 

und der in der Netzliste erscheint. Dieser Name kann auch alpha-numerisch sein 

(A43, B43, C43, und so weiter) 

 Logic Name – Ein Name der die Funktion des Pins beschreibt, zum Beispiel CLK, 

RESET, und so weiter 

 Pin Swap – Dies definiert Pin-Tausch Informationen für das automatische und 

manuelle Tauschen von Pins 

 Gate Swap - Dies definiert Gatter-Tausch Informationen für das automatische und 

manuelle Tauschen von Pins 

 Net Name – Definiert den Namen des Netzes, an das der Pin im Design 

automatisch angeschlossen wird. Wird im Allgemeinen für Power und Ground 

Pins verwendet 

 Pin Type – Definiert die elektrische Funktion des Pin (Input, Output, Power, und 

so weiter) 

 Footprint Pin – Dies ist die Pin-Reihenfolge, die beim Editieren des PCB 

Footprints erscheint 
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Der Arbeitsablauf des Part Editors 

Der Parts Editor erlaubt das Erstellen von Parts Definitionen mit Hilfe von Dialogen, 

die in mehrere Register unterteilt sind 

 Jedes Register enthält ein anderes Element des Parts 
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Erzeugen und Hinzufügen eines Schaltplan 
Symbols 

 Parts können teilweise erstellt werden, mit fehlenden Elementen wie zum Beispiel 

Schaltplansymbolen 

 Schaltplansymbole werden im Schaltplan verwendet, um Gatter des Parts zu 

repräsentieren 

 Symbole können im Symbol Editor oder im Symbol Wizard erstellt werden 

 Der Part Name verbindet das Part mit dem Schaltplan und dem PCB 

 Eine Part Definition kann eine Mischung unterschiedlicher Symbole enthalten 

 

Der Symbol Editor 

Der Schematic Symbol Editor wird zum Verwalten der Schaltplansymbole verwendet 

 Der Editor ist verfügbar im Library Manager Dialog, im Schematic Symbols 

Register 

 

 In diesem Dialog kann das Technology File ausgewählt werden 

 Das Technology File wird für neue Symbole verwendet, und beim Editieren 

bestehender Symbole 

 Das Technology File bestimmt außerdem die Farbeinstellungen (Farben und 

Sichtbarkeiten) in der Vorschau und im geöffneten Symbol 

Verwenden des Symbol Editor 
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Die Grundlagen eines Symbols  

 Um an ein Symbol Verbindungen anzuschließen, muss es Pins haben 

 Shapes werden verwendet um den Körper des Symbols zu zeichnen 

 <Component Name> und <Part Name> Platzhalter können eingefügt werden 

 <Logic Name> Attribute Platzhalter können eingefügt werden 

 Jeder Attributname kann als Platzhalter eingefügt werden 

 Der Ursprung des Symbol (Symbol Origin) liegt üblicherweise auf Pin 1 

 Der Ursprung des Symbols wird bei dessen Platzierung verwendet 

Pins hinzufügen 

 Standardwerte für den zuerst gesetzten Pin werden aus dem Design Settings 

Dialog, Defaults Seite, verwendet 

 Dieser Wert wird verwendet, solange kein Terminal im Design selektiert wurde 

 

 Die Information in diesem Dialog wird aus dem Technology File genommen 

 Die Pad und Name Styles werden für die Pins und Pinnummern verwendet 

 Verwenden Sie die Insert Pin Option aus dem Insert Menü zum Hinzufügen von 

Pins 

 

 Wenn der Pin eingefügt wurde, wird diesem die nächste freie Pin-Nummer 

zugewiesen 

 Das Rastermaß kann im RMT Menü unter Change Grid eingestellt werden 

 Wählen Sie ein Rastermaß, das identisch ist mit dem Raster das im Design für die 

Platzierung und die Pins verwendet wird 

 Verlassen Sie den Insert Pin Modus mit der ESC Taste, dann wird der aktuell am 

Cursor hängende Pin wird gelöscht 

 Sobald alle Pins platziert sind, können Sie die Pinnummern auf die gewünschten 

Positionen ziehen 

 Charakteristiken des Pins können nach dem Platzieren geändert werden, die 

bessere Methode ist es allerdings, diese schon vorher einzustellen 

Symbol Pin Regeln 

 Pin 1 besitzt einen Kreis mit einem Kreuz, das den Symbol-Ursprung anzeigt 

 Dieser Ursprung wird automatisch eingefügt, wenn Pin 1 platziert wird, er kann 

aber jederzeit interaktiv verschoben werden 

 Der Symbol-Ursprung wird immer mit dem ersten Element eines Symbols 

eingefügt 

 Durch eine Konvention in der Bibliothek, sitzt der Ursprung am Anfang immer auf 

Pin1 

 Verwenden Sie Renumber Pins oder die Auto Renumber Pins Option aus dem 

Utilities Menü, um Pin-Nummern zu ändern 

 Jede Pin-Nummer muss eindeutig sein, bevor das Symbol in der Bibliothek 

gespeichert werden kann 
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 Die Pin-Nummer repräsentiert nur den Pin im Symbol, diese Nummer/Name kann 

im Part geändert werden 

 Eine korrekte Pinnummerierung im Symbol vereinfacht das Editieren von Parts 

Symbol Shapes (Formen) hinzufügen 

 Verwenden Sie Insert Shape aus dem Insert Menü 

 Wählen Sie die benötigte Form 

 Zeichnen Sie die gewünschte Form 

 Das RMT Menü hilft Ihnen beim Hinzufügen und Editieren der Form 

Bögen erzeugen (Arcs) 

 Erzeugen Sie eine orthogonale Form mit dem Segment Mode, um gerade Linien 

mit 90° Ecken zu erzeugen (Sie können keine Bögen aus nicht-orthogonalen Linen 

erzeugen) 

 

  

 Wählen Sie das Segment und öffnen Sie das RMT Menü, und dort Arc 

 Wählen Sie den Arc Stil aus. Wenn Sie Edit wählen, ziehen Sie den Bogen auf die 

gewünschte Größe 

 

  
 

 

Ein Detail im Shape hinzufügen 

 Zeichnen Sie kurze Einzellinien um die Verlängerungen der Pins zu zeichnen 

 Verwenden Sie den Insert Shape Line Modus 

 

 Verwenden Sie Insert Shape Circle um den schmalen NICHT Kreis einzufügen 

(Auf Pin 3) 
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 Es kann sein, dass das Raster mit Use no Grid im RMT Menü abgeschaltet 

werden muss, um den Kreis zu platzieren. Das erlaubt die genaue Ausrichtung des 

Kreises 

 

Position des Komponentennamen festlegen 

 Der Component Name und die Platzhalter des Part Name Attribut werden 

verwendet, wenn das Symbol im Schaltplan verwendet wird 

 Wählen Sie Component Name aus dem Insert Menü 

 Falls benötigt, wird der Part Name als ein Attribut eingefügt 

Part Name Attribut einfügen 

 Der Part Name hat keine eigene Menü Option 

 Der Part Name wird als ein Namens Attribute eingefügt 

 Dieser Prozess ist gleich, wenn eine Part-Beschreibung, Symbol-Name, und so 

weiter eingefügt wird 

 Wählen Sie Insert Attribute Position aus dem Insert Menü 

 

 Aus der Drop-Down Liste, selektieren Sie <Part Name> 

 Klicken Sie OK und positionieren Sie den Platzhalter 
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Logic Name Attribut einfügen 

 Weitere Attribute, wie der Logic Name, können in dem Symbol benötigt werden 

 Der Name kann mit der Insert Attribute Option eingefügt werden 

 Der Attribute Value ist als Place Holder Only definiert, weil es keinen Wert 

gibt, der dem Attribute genügt (es wird erst in der Part Definition eingeführt) 

  

 Der Logic Name ist als ein Pin Attribute an den Pin gehängt  

 Verwenden Sie die <Logic Name> Attribute Properties, um die Textausrichtung 

(Text Alignment) einzustellen 

  

 Wenn Sie Pins hinzufügen, hängen Sie den Logic Name an den ersten Pin und 

kopieren Sie den Pin 

  

 Mit Save To Library speichern Sie das Symbol 
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Hinzufügen des Symbols zur Part Definition 

 Die Gates Seite erlaubt es dem Part Gatter (Symbole) hinzuzufügen 

 Die Optionen sind verfügbar auf der Werkzeugleiste oder dem RMT Menü in der 

ausgewählten Zelle 

 

 Wählen Sie das Gatter aus der Liste 

 Filtern Sie die Liste der verfügbaren Gatter mit der Search By Pin Count Check-

Box 

 Verwenden Sie die Add Box, um die Anzahl der ausgewählten Gatter festzulegen 

 

Part speichern 

 Verwenden Sie das File Menü und die Save To Library Option 
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PCB Footprints erzeugen 
PCB Footprints repräsentieren im PCB Design das physikalische Symbol , das im 

fertigen PCB verwendet wird 

 Der Part Name setzt das Schaltplan Symbol mit dem PCB Footprint in Beziehung 

 

 Eine Part Definition enthält das Schematic Symbol und den PCB Footprint 

 Der PCB Footprint Editor wird aus dem Library Manager Dialog gestartet 

 

 Das ausgewählte Technology File bestimmt mit welcher Technologie ein neuer 

Footprint erstellt oder ein bestehender Footprint editiert wird 

 Das aktive Technology File legt die Darstellung (Farben und Sichtbarkeiten) des 

Footprints in der Vorschau und im Editor fest 

Verwenden des Footprint Editor 

 Der Footprint Editor ist ein spezieller Modus zum Erstellen von Footprints 

 Der Footprint Editor arbeitet wie der PCB Design Editor 

 Footprints können durchkontaktiert, SMDs und eingebettet sein 
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Footprint Grundlagen 

 Ein Footprint enthält Pads, diese werden zur Anbindung der Leitungen benötigt 

 Er kann weiterhin Mounting Holes, Kupfer, Shapes, Areas, Attribute, Leitungen 

(keine Verbindungen) und Text enthalten 

 Shapes und Areas werden zum Definieren des Bestückungsdrucks und für 

Placement Outlines verwendet 

 Sie können Component Name und Part Name Platzhalter einfügen 

 Footprints sollten mit dem selben Technology File erstellt werden, wie die PCB 

Designs 

Pads hinzufügen 

 Pads werden als elektrischer Verbindungspunkt definiert 

 Pads sind im PCB Design 3-Dimensional 

 Pad Styles sollten aus dem Technology File verwendet werden 

 Es ist besser zuerst den Style des ersten Pads zu ändern und dieses Pad dann zu 

kopieren 

 Verwenden Sie die Insert Pad Option zum hinzufügen von Pads 

 Wenn das letzte Pad gesetzt wurde, verwenden Sie ESC um den Modus zu 

verlassen (das noch am Cursor befindliche Pad wird gelöscht) 

  

 Verwenden Sie Change Grid im RMT-Menü, um ein anderes Platzierungsraster 

auszuwählen 

 Verwenden Sie ein Raster, das dem Pinraster entspricht 

 Nach dem Platzieren aller Pads kann es nötig sein, die Pin Nummern auf eine 

bessere Position zu verschieben 

 Diese Nummern dienen nur zu Referenzzwecken, es sind nicht die später 

angezeigten Pin-Nummern 

 Ändern Sie die Charakteristiken eines ausgewählten Pads über das RMT-Menü 

 

 Es ist besser zuerst das erste Pad mit seinem Style und der Pin-Nummer Position 

zu setzen. Wenn es selektiert ist, verwendet Insert Pad diese Eigenschaften für die 

weiteren Pads 

 Wenn Pads eingefügt wurden, kann Renumber Pins oder die Auto Renumber 

Pins Option verwendet werden, um die Reihenfolge der Nummer zu Ändern 

 Jede Pad-Nummer muss eindeutig sein, bevor der Footprint in die Bibliothek 

gespeichert werden kann 

Footprint Symbol Origin 

 Jeder Footprint enthält einen Ursprung (Symbol Origin) – einen Kreis mit einem 

Kreuz 
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 Der Ursprung ist der Referenzpunkt zum Platzieren und Verschieben des 

Footprints 

 Dieser Ursprung wird automatisch eingefügt, sobald der erste Pin oder das erste 

Shape gesetzt wird, er kann aber jederzeit interaktiv verschoben werden 

 Die Standard-Konvention in der Pulsonix Bibliothek verwendet immer Pad 1 bei 

durchkontaktierten Footprints, und den Footprint-Mittelpunkt bei SMD Bauteilen 

  

Pad Reassignments 

 Pads die einen unterschiedlichen Aufbau oder Style (Größe oder Form) auf 

unterschiedlichen Lagen benötigen werden in der Technology definiert 

 Im Grunde erstellen Sie ein flaches ‘Bild’ des Footprints (Fläche und Pads) die der 

Footprint einnimmt, wenn er im PCB Layout eingesetzt wird 

 Das Pad-Reassignment ist die zusätzliche  3-dimensionale Beschreibung, die für 

Mehrlagen- Boards verwendet wird 

 Innerhalb der Technology auf der Pad Styles Seite, verwenden Sie den By Layer 

Schalter, um die Pad Reassignments zu definieren 

 

Montagebohrungen (Mounting Holes) 

 Montagebohrungen unterscheiden sich von normalen Pads 

 Sie sind nicht nummeriert 

 Das heißt, Sie erscheinen nicht in der Padliste des Part Editor, wenn der Footprint 

in einem Part verwendet wird 

 Da es sich um Pads handelt, können sie angeschlossen werden, obwohl sie in 

keiner Netzliste auftauchen 

 Montagebohrungen verwenden ihre Grundeinstellungen aus dem Design Settings 

Dialog  Mounting Holes 

 Wie bei normalen Pads, kann der Pad Style der Montagebohrung verändert 

werden, indem die Change Style Option des RMT-Menüs verwendet wird 

Shapes hinzufügen 

 Sie können Shapes als Kupfer, Documentation Shapes und Areas einfügen 

 Alle Shape-Types im Footprint-Editor sind lagenspezifisch 

 Alle Shapes verwenden die Standardeinstellungen aus dem Design Settings 

Dialog unter Defaults 

 Wählen Sie den gewünschten Shape unter Insert  (Shape-Type) aus 
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 Ändern Sie Layer und Style 

 Das RMT Menü ermöglicht die Auswahl, ob das Shape Open oder Closed ist 

 Bei den meisten Footprints werden mehr als ein Shape-Type nötig, zum Beispiel 

Bestückungsdruck (Silkscreen) oder Platzierungslinie (Placement Outline) 

 

 Die Placement Outline wird auf der benötigten Lage definiert <Top Side> oder 

<Through Board> 

Placement Shapes 

 Placement  Outlines werden verwendet, wenn die Komponente manuell oder per 

Autoplacer im Design bewegt wird 

 Während des Design Rule Checks werden die Placement Outlines verwendet, 

um die Platzierung zu prüfen 

 Sind keine Placement Outlines definiert, wird eine Component Bounding Box 

verwendet (Das System berechnet eine Placement Outline um alle Elemente des 

Footprints herum) 

 Placement Outlines sind als Areas definiert 

 Sie werden speziell als Placement Areas definiert, indem die Checkbox in den 

Properties der Area gesetzt wird. 

Definition eines Bauteils als SMD 

 Als Standard werden die Pads als <Through Board> definiert 

 Für SMD Bauteile sollten sie lagenspezifisch eingestellt werden, also als <Top 

Side> oder <Bottom Side> 

 Im Allgemeinen werden SMD Pads als <Top Side> definiert 

 

Definition der Pad Seite 

 Fügen Sie das erste Pad im Footprint ein. Verwenden Sie Change Layer aus dem 

RMT-Menü 

 

 Die New Layer Drop-Down-List erlaubt die Auswahl der benötigten Lage 

(<Through Board>  zu <Top Side>) 
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Shapes die beim Spiegeln die Lage tauschen 

 Shapes können automatisch gespiegelt werden, sofern sie eine Gegenlage definiert 

haben 

 Um eine Silkscreen-Outline von <Top Side>, auf die <Bottom Side> zu spiegeln, 

muss es eine Layer Class in der Technology geben, die den selben Type 

verwendet, zum Beispiel <Silkscreen Top>, und eine ‘Gegenlage, zum Beispiel 

<Silkscreen Bottom> 

 

Definition der Component Name Position 

 Der Platzhalter für den Component Name ist ein Attribut, das über das Insert 

Menü aufgerufen werden kann 

 Innerhalb des Footprint-Editors, wird das Component Name Attribut nicht 

ausgefüllt, nur der Platzhalter wird gesetzt 

 Solange der Footprint nicht als Teil eines Parts in einem PCB Design verwendet 

wird, gibt es keinen Wert für den Component Name, wie zum Beispiel U1, IC1 

und so weiter 

 

 Der Platzhalter für den Component Namen ist außerdem lagenabhängig, sollte 

aber auf dem Silkscreen liegen 

 Style und Lage können während der Platzierung, oder später erfolgen 

 Es können weitere Instanzen des Component Name hinzugefügt werden 

 Mehrere Instanzen sind erforderlich, wenn der Component Name auf 

unterschiedlichen Lagen auftauchen soll, zum Beispiel auf einer elektrischen 

Kupferlage 

 Dafür fügen Sie ein <Component Name> Attribut hinzu, und ändern seine Lage 

 Mit Save To Library speichern Sie den Footprint 
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Attribute hinzufügen 

 Dem Footprint können zusätzliche Platzhalter für Attribute hinzugefügt werden 

 Sie können auch ein Attribut mit Werten in einen Footprint einfügen 

 Das können Attribute sein, dessen Werte für einen speziellen Footprint wichtig 

sind 

 Verwenden Sie Attribute Position aus dem Insert Menü 

 

 

Part erstellen 

Part Technology Dateien 

 Part Technology Files enthalten vordefinierte Netz- und Attribut Namen 

 Dadurch bleiben verwendete Namen konsistent 

 

Starten des Part Editors 

 Mit dem  Part Editor Register können Sie neue Parts erstellen, oder bestehende 

ändern 

 

 Wenn Sie ein Part selektieren, wird Ihnen eine Vorschau des Parts, oder seiner 

Details angezeigt 

 Wechseln Sie mit den Registern Preview / Detail zwischen diesen beiden Modi 
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 Verfügbare Bibliotheken werden im Folders Register ausgewählt 

 Current Library kann <All Libraries> sein, oder eine selektierte Bibliothek 

 

Erzeugen von Basic Parts 

 Klicken Sie den New Schalter, um ein neues Part zu erstellen 

 

 Erlaubt die Definition des Part Type (durch Verwendung der Radioschalter) 

 Es können Schaltplan oder PCB Details definiert werden 

 Schaltplan Details können teilweise oder vollständig eingegeben werden, der Rest 

kann später eingetragen werden 

 Durch Eingabe der Pin-Anzahl (Pin Count), werden die verfügbaren PCB 

Footprints eingeschränkt 

 Schaltpalnsymbole können Einfach- oder Mehrfach-Gatter sein 

 Power und Ground Pin-Nummern können vordefiniert werden 
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Der Parts Editor 

Detail Register 

 Das Details Register wird für die High Level Definition des Parts verwendet 

 Es zeigt Information, die bei der Erstellung eines neuen Parts angelegt wurden 

 Der Spice Type Eintrag wird zum Mappen des Part-Namen auf ein Spice Modell 

benötigt, sofern Sie die Simulation nutzen 

 

Footprints und alternative Footprints 

 Verwenden Sie den Choose Schalter zum selektieren des gewünschten Footprints 

 

 Setzen Sie den Schalter Preview, um eine Vorschau des Footprints zu erhalten 

 

 Verschieben Sie die gewünschten Footprints von der linken auf die rechte Seite 

des Dialogs 
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Footprint und Gates Register 

 Das Pins Register verwaltet die Footprint Information, wie alphanumerische 

Namen und vordefinierte Netznamen 

 

 Das Gates-Register definiert Symbol Informationen, wie Gate & Pin Swap 

Informationen und Logic Names 

 

Parts und Attribut Register 

 Das Parts and Attributes Register wird aus zwei Gründen verwendet: 

Um Part Groups zu definieren und um Part basierte Attributes einzufügen 

 Part Attribute sind in Komponenten immer verfügbar, im Schaltplan und im PCB 

Design 

 Attribute können im Library Manager  Attribute Editor modifiziert werden, 

 

 Wählen Sie Insert Attribute, wenn Sie ein neues Attribut einfügen wollen 

 Tippen Sie den Namen ein oder wählen Sie ihn aus der Liste, und geben Sie den 

Wert ein 
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Pins Register 

 In diesem Register werden die PCB Footprint Pins mit den Pin Names gemappt 

 Pin Names werden sowohl im Schaltplan Symbol, als auch im PCB Footprint 

Symbol Editor angezeigt 

 Pin Names können alphanumerisch sein, zum Beispiel A1, A2, B1 und so weiter 

 

 Der Footprint Pin Name ist die aktuelle Reihenfolge der Pads, die beim Erstellen 

des Footprints zugewiesen wurde 

  Montagebohrungen haben keinen Pin Namen 

 

 Das Pin Type Feld kann zugewiesen werden und wird beim ERC im Schaltplan 

verwendet 

 Das Register kann auch Pin Attributes enthalten 

Vordefinierte Netznamen 

 Net Names sind die Signal-Pins mit vordefinierten Netznamen, wie GND 

 Diese werden für ‘unsichtbare’ Pins verwendet, die im Schaltplan nicht sichtbar 

sind, aber ein vordefiniertes Netz führen  

Gates Register 

 Das Gates Register fügt der Part Definition die Schaltplan Symbols hinzu  

 

 Verwenden Sie diese Seite, um Logic Names und Gate & Pin swapping 

Informationen einzufügen 

 

 

http://www.tecnotron.de/


Pulsonix Seminar 87 

Tecnotron elektronik gmbh Wildberg 64 88138 Weißensberg 

www.tecnotron.de  08389 / 9200 - 406 

 Mit Insert Gates fügen Sie Gatter ein 

 

 Die (Schematic Symbol) Library Liste ermöglicht Ihnen die Suche in der 

ausgewählten Bibliothek oder allen verfügbaren Bibliotheken 

 Mit dem Add Schalter wählen Sie ein Symbol aus der Liste 

 Mit dem Search By Pin Count Eintrag können Sie die Liste filtern. Nur Symbole 

mit der passenden Anzahl an Pins werden angeboten 

 Sie können mehr als ein Gatter auswählen, und Sie können unterschiedliche 

Gattertypen mischen 

 Mit der Delete Option aus dem RMT Menü löschen Sie unerwünschte Gatter 

 Einmal eingefügte Gatter können geändert werden 

 Sie können sie gegen ein anderes Gatter Symbol tauschen 

 Sie können die Gatter Reihenfolge ändern 

 

Logic Names hinzufügen 

 Doppelklicken Sie auf eine Zelle, um sie zu editieren 

 Logic Names benötigen den <Logic Name> Attribute Platzhalter am Symbol Pin, 

damit dieses Attribut im Design angezeigt werden kann 

Gatter & Pin Tausch Information 

Gate & Pin Swap Information wird für den automatischen und manuellen Pintausch 

verwendet 

Die allgemeinen Regeln sind: 

 Pins innerhalb des gleichen Gatters, mit der gleichen Swap Group, sind tauschbar.  

 Ein Pin oder Gatter mit der Swap Group ‘0’ ist nicht tauschbar 

 Im Beispiel unten wurden die Input Pins auf Pin Swap ‘1’ gesetzt, so dass sie 

innerhalb ihres Gatters tauschbar sind 

 Außerdem haben die Gatter die Gate Swap Group ‚1’, damit sie untereinander 

tauschbar sind, innerhalb der Komponente und extern mit anderen Komponenten 

des gleichen Parts 
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Associated Parts 
Associated Parts sind zusätzliche mechanische Parts, die an elektrische Parts angehängt 

werden. Sie fügen dem einen Part weitere Informationen hinzu, wie zum Beispiel die 

Part-/Bestellnummer der mechanischen Parts. Dadurch werden durch Platzieren eines 

einzigen Symbols/Parts, die Stücklisteninformationen der mechanischen Parts mit 

eingefügt. Zum Beispiel Platzieren eines Sicherungssymbols bringt neben der 

Glassicherung auch die beiden Halter in die Stückliste. 

 Associated Parts können aus einer Liste von Parts ausgewählt werden, die keine 

Pads besitzen 

 

 

Parts speichern 

 Speichern Sie das Part mit Save To Library 

 

Parts aktualisieren (reload Part) 

 Parts, Footprints und Symbole können aus der Bibliothek aktualisiert werden 

 Verwenden Sie die Reload From Library Option aus dem Tools Menü oder dem 

RMT Menü   
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Unterschiedliche Part Typen 

Relais 

 Ein Standard Relais verwendet zwei unterschiedliche Schaltplansymbole und 

einen Footprint 

 Es wird ein vier Pin Footprint verwendet, obwohl das Raster eines DIP14 

Footprints verwendet wird 

 Der Footprint ist mit Pin-Nummern 1 bis 4 definiert 

 Das Pin Register definiert die tatsächlich benötigten Pin-Namen 1,2,7,8 

 

 

Stecker (Connector Parts) 

 Ein Part wird als Connector Part definiert 

 Das erlaubt uns den Stecker aus dem Insert Connector Dialog zu wählen 

 Ein Connector Part hat kein Gates Register - ein Schaltplansymbol wird 

ausgewählt, jeder Pin ist ein eigenes Gatter 
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Alpha-numerische Pinnamen 

 Alpha-numerische Namen werden unter Part Editor > Pins Register  > Pin 

Names definiert 

 
 

 

Bibliotheken Wizards 

Schaltplan Symbol Wizard 

 Der Symbol Wizard unterstützt uns beim Erstellen von Schaltplansymbolen 

 Das Vorschaufenster (Preview Window ) zeigt, wie das Symbol aussehen wird 
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PCB Footprint Wizard 

 Im allgemeinen werden die Anwender einfache Footprints manuell erzeugen, wie 

zum Beispiel Widerstände 

 

 Wenn bei der Erstellung von BGA Bausteinen, der Schalter Automatic Creation of 

Part, auf der Finish Seite ausgewählt ist, werden die Pins alpha-numerisch 

benamt, bezogen auf ihre Reihen und Spalten 

Part Wizard 

 Der Part Wizard bietet eine schnelle Möglichkeit zum Erstellen von Parts 
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Beispiel Schaltplan 

 

 

 

Hinweise: 

Verwendete Pulsonix Bibliotheken [die Attributnamen für die Bauteilwerte sind ggfs. In 

eckigen Klammern angegeben]: 

- Coilcraft (Spule 1008CS-221XFLC) [L] 

- Resistor (Widerstände) [R] 

- Capacitor (Kondensatoren) [C] 

- TI (IC’s TLC3702CD, SN74HC74N und SN74LS07D) 

- Trans (Transistor BC337) 

- Diode (Diode 1N4002) 

- Molex (Stecker 53047-06) 

- Docsymbols (Ground Symbol Gnd) 
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Beispiel Datenblatt 
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Notizen 
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